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Introduction 

 

This booklet is designed to offer a quick reference to get you familiar with the Microsoft Windows 7 

operating system. You will learn tips to get started using Windows 7, such as launching applications to 

managing files and windows.  

A comparison of the new and improved features in the Windows 7 operating system is available in the 

appendix of this booklet. 

 

Also note that the examples and illustrations in this booklet use Microsoft Word 2010 and Internet 

Explorer. 
 

 

Learning Objectives 

 

The learning objectives covered in this document will provide you with the essential information 

needed to: 

 

 Quickly learn essential tasks such as running an application, printing and saving a file, locking 
the computer, and logging off. 
 

 Learn the system's user interface, including the start menu, taskbar, desktop gadgets, aero 
peek, shake, snap, and more. 
 

 Learn how to use tools for speech recognition, searches, screen captures, as well as image and 
video editing. 
 

 Learn how to use the ease of access features of Windows 7.  
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Getting Started with Windows 7 

Opening 
 

How to Open Programs 

 

Follow the steps below to open software programs in Windows 7: 

 

1. Click the Start button. 
 

2. Select All Programs. A list of all installed programs will appear.  
 

3. Use the scroll bar to go through the list. 
 

 
   Figure 1 – All Programs 

4. Click the Microsoft Office folder.  
 
Note: In some instances, such as when opening Microsoft Word, it may be necessary to click on a 
folder to open a list of grouped applications. 

 

 

 

 

 

 

 

 

 

Figure 2 - Accessing Microsoft Word 2010 
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5. Select Microsoft Office Word 2010, the MS Word 2010 program will open. 
 

How to Open a Web Browser  

 

Follow the steps below to open a web browser: 

 

1. Click the Start button. 
 

2. Select All Programs. A list of all installed programs will appear.  
 

 
                      Figure 3- All Programs 

3. Use the scroll bar to find the web browser you wish to use  
 

4. Select the web browser. The web browser page opens.  
 
Note: Internet Explorer and Mozilla Firefox are the Internet browsers automatically loaded on 
campus computers. 
 

Saving 

How to Save a Document 

 

When you are working with a document in a program, such as Microsoft Word, you should save 

frequently to avoid losing data unexpectedly due to a power failure or other problems. 

 

To save a Word Document:  

 

1. Click on the File tab (located towards the top left corner). 
 

2. Select Save. The Save As dialog box will appear. 
 

3. From the navigation pane on the left, select the location you wish to save the file to. 
 

Figure 4 – File Tab 
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                  Navigation Page -Figure 5 

 

4. In the File Name field, type a name for your document. 
 

5. By default, the document will be saved as a Word 2010 document. To select a different format: 
 
5.1. Click the Save as type field. 

 
5.2. Select the file type you wish to use. 

 

6. Click the Save button.   
 

How to Save a Copy of a Document 

 

This function will allow you to preserve an original document. To save an existing document as a new 

document: 

 

1. Click the File tab in Microsoft Word at the top left corner.  
 

2. Click Save As.  The Save As dialog box will appear. 
 

Figure 6 – File Tab 
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3. From the navigation bar on the left, select the location where you want to save the document. 
 

4. In the File Name field, type the name of the file. 
 

5. Click the Save button. 
 

How to Use a USB Storage device 

 

USB Storage devices include flash drives and external hard drives. 

 

To connect a USB storage device to the computer: 

 

1. Locate the USB port in the front or in the back of your computer. 
 

2. Insert the USB Storage device into the USB port. 
 

3. If the device is inserted correctly, you will receive a prompt that the device is being installed.  
 

Note: If the prompt does not appear, unplug the device and insert it again. If problems persist, contact 
the ITS Service Desk at (770)423-6999. 

4. Your device is now ready for use. 
 

To save MS Word 2010 documents to a USB Storage device: 

 

1. Click the File tab in MS Word at the top left corner. 
 

2. Click Save As.  The Save As dialog box will appear. 
 

3. From the navigation pane on the left, under the Computer heading, select the USB device you wish 
to save the file to. 

 

Note: The device may appear as Removable Disk (E:)  

4. In the File Name field, type the name of the file. 

 

5. Click the Save button. 
 

 

Figure 7 – USB Port 

Figure 8 – File Tab 

Figure 9 – Removable Disk 
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How to Safely Remove a USB Storage Device 

 

When using a USB device, it is important to disconnect the device properly to avoid loss of data. Before 

unplugging a storage device, such as USB flash drive, make sure that the computer has completed 

saving. If the device has an activity light, wait a few seconds after the light has finished flashing before 

unplugging it. 

 

To safely disconnect a USB device: 

 

1. Locate the USB icon on the right side of the taskbar.  
 

2. Click the USB icon, a notification will be displayed.  
 

3. Select the USB device you want to disconnect.  
4. Click the Eject option. 

 

5. Windows will display a notification informing you it is safe 
to remove the device. 
 

 
Figure 12 – Safe to Remove Notification 

 

6. Remove the USB device from your computer. 
 

Printing 

How to Print  

 

To print a document from Microsoft Word: 

 

1. Click the File tab in MS Word at the top left corner. 
 

2. Select Print, the print options appear to the right. 
 

3. To the right of the Print button, from the Copies field, set the 
number of copies you wish to print. 

 

Figure 10 – USB Icon 

Figure 11 – Eject Option 

Figure 13 – File Tab 

Figure 14 – Copies Field 
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4. To select a printer, click the button below the Printer label. 
 

5. Select the printer you wish to use. 

Note: If you click the Printer Properties link below the printer button, 

additional printer options are available. 

 

6. Click on the Print button.  
 

 
 

 

Note: If more printer options are needed move to step 7. 

 

To configure Print Settings: 

7. To set the print page range, click the button below the Settings 
label. 
                                                                                                 

8. In the Pages field enter the page range you wish to print  

(i.e. 1 – 10). 
 

9. Click the Print One Sided button to change how the document will print on the paper. 
 

10. Click the Collated button to select how the document will be 
collated. 

 

11. Click the Portrait Orientation button to change the page 
layout. 

 

12. Click the Letter button to change the page size. 
 

13. Click the Normal Margins button to change the page 
margins. 

 

14. Click the 1 Page per Sheet button to change the number of 
pages printed per sheet. 

 

15. Click the Page Setup link to make additional changes. 
 

 

Figure 15 – Printer Selection Button & 
Printer Properties 

Figure 17 – Print All Pages Button 

Figure 18 – Additional Print Options 

Figure 16 - Print Button 
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16. After making all the needed selections, click the Print icon at the top of the print 
options. 

 

Keeping the Computer Secure 

How to Lock your Computer 

When you step away from your computer, keep it secure by locking it: 

1. Using your keyboard, press the window logo key        + the L key, the screen will be locked. 
 

2. To unlock the screen, press Ctrl + Alt + Delete. 
 

3. Enter your NetID password (the password you used to login to the computer). The screen will be 
unlocked. 

Shutting Down  

Turning off your computer properly 

 

When you are finished using your computer, it is important to turn it off properly—not only to save 

energy, but also to help keep your computer more secure and to ensure that your data is saved. 

 

Note: Shutting down your computer does not save your work.   

It is important that you save your files before shutting down. 

 

To turn off your computer: 

1. Click the Start button.  
 

2. Click the Shut down button.  
 

3. If programs are still open, Windows will prompt you with the following options: 
 

 Force Shutdown 
OR 

 Cancel 
 

4. If you do not take action, Windows will force closing on all programs and shut down your 
computer. 
 
 
 

Figure 20 – Shut down Button 

Figure 19 – Printer Icon 
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Additional Shut down Options 

 

Windows 7 provides you with different ways to close open programs, shut down windows, and turn off 

your computer. 

 

Note: Before attempting any of the shut down options, make sure to save any open files.   

 
 

 
Figure 21 – Shut down Options 

To access the shut down options: 
 

1. Click on the Start button. 

2. Locate the Shut down button in the lower right-hand of the Start menu. 

3. Click the arrow to the right of the Shut down button to view the shut down options. 

3.1. Log Off - When you log off from Windows, all of the programs you were using are closed, but 
the computer is not turned off. 

3.1.1. Select Log off from the menu of shut down options. 

 

3.1.2. If programs are still open, Windows will prompt you with the 
following options: Force Log off OR Cancel. 

3.1.3. If you do not take action, Windows will force closing on all 

programs and log you off the computer. 

3.2. Switch User – If more than one user is to use the computer, there is a quick way to allow the 
other user to access their account without having to shut down completely. 

3.2.1. Select Switch user from the menu of shut down options. 

3.2.2. Press Ctrl+Alt+Delete. The other user will then be able to enter their NetID and   
password to log in. 

3.3. Restart – This option allows you to reboot your computer. This is also referred to as soft boot. 

3.4. Sleep – This option does not turn your computer off; instead it puts it in a low power mode.  
 

Figure 22 - Log off option 
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Note: The Sleep option allows the computer to start again quickly without having to do a full 
reboot (which may take several minutes). 

 To resume from the Sleep mode, press the Esc key or the mouse wheel.  

3.5. Hibernate – This option is a combination between a complete Shut Down and a Sleep mode.  
The Hibernate option saves the most power and it is designed primarily for laptops. 

Note: The Hibernate mode remembers the current state of your desktop (i.e. if you have an open 
web browser, an open word document), as it turns off your computer. The next time you start 
your computer, the applications you were using will be waiting for you. 

 To resume from the Hibernate mode, press the computer’s power button.  
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Utilizing the Taskbar 

How to Organize Buttons  

 

The Taskbar is located along the bottom frame of your monitor.  The taskbar displays the Windows 

Start, currently running programs, and quick launch buttons, as well as clock and date. The Quick 

Launch buttons as well as any other program or document pinned to the taskbar can be moved to a 

different location. 

 

To change the location of a button: 

 

1. Click and hold the button. 

 

2. Drag the button to a different location. 

 

3. Drop the button by releasing the mouse. 

 

How to Use Thumbnail Previews 

 

When you hover over the button of minimized windows, you will see a preview of them in the form of 

thumbnails. For example, if you have three Internet Explorer windows open and hover your mouse 

cursor over the Internet Explorer icon on your taskbar, it will pop-up three small images of each of your 

Internet Explorer windows and allow you to select the one you want to make active.  

 

 
Figure 23 - Thumbnail Previews 
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How to Pin a Program to the Taskbar 

 

You can pin a program directly to the taskbar so that you can open it quickly and conveniently, rather 

than having to look for the program in the Start menu each time. 

 

1. If the program you wish to pin to the taskbar is not 
running: 
 
1.1. Click the Start button.  

 
1.2. Click All Programs. 

 
1.3. Find the program you want, right-click the program. 

 
1.4. Select Pin to Taskbar. 

 

2. If the program you wish to pin to the taskbar is running: 

2.1. Right-click the program button on the taskbar. 
  

2.2. Click on Pin this program to taskbar. 
 

How to use Jump Lists 
 

Jump Lists are lists of recently opened items, such as files, folders, or websites, organized by the 

program that you use to open them. You can use a Jump List to open items, and you can also pin 

favorites to a Jump List, so you can quickly get to the items that you use often. 

 

How to work with Jump Lists from the Taskbar: 

 

To view the Jump List for a program: 

1. Right-click the program's button on the taskbar. 
 

To open an item from a Jump List: 

1. Open the program's Jump List.  
 

2. Click the item. 
 
 
 

Figure 24 – Pin to Taskbar 
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To pin an item to a Jump List:  

1. Open the program's Jump List.  
 

2. Point to the item.  
 

3. Click the pushpin icon.  
 

4. Click Pin to this list.  
 

To unpin an item: 
 

1. Open the program's Jump List. 
 

2. Point to the item.  
 

3. Click the pushpin icon.  
 

4. Click Unpin from this list.  
 

 

Figure 25 - Jump Lists from Taskbar 

 

 

  



 

Created:  8/5/2010  Page 14 of 59 
Revised: 11/16/2010   
  

Optimizing the Desktop Experience 

 

How to Toggle between Windows with Aero Flip 3D 

 

Aero Flip 3D allows you to toggle between the different open/active programs listed on your taskbar. 

 

1. Press and hold the Windows logo key         on your keyboard. 
 

1.1. While holding down the Windows logo key, press the Tab key repeatedly to cycle through the 
open windows. 

 

OR 
 

1.2. Rotate the mouse wheel to cycle through the open windows. 
 

2. Release the Windows logo key to display the window in front of the stack. 
 
OR 
 

3. Click any part of any window in the stack to display that window.  The selected window will be 
displayed. 

How to Pin a Program to the Start Menu 
 

You can pin a program directly to the Start Menu so that you can open it quickly and conveniently, 

rather than having to look for the program in the All Programs menu each time. 

 

3. If the program you wish to pin to the taskbar is not running: 
 
3.1. Click the Start button.  

 
3.2. Click All Programs. 

 
3.3. Find the program you want, right-click the program. 

 
4. Select Pin to Start Menu. 

If the program you wish to pin to the Start Menu is running: 

4.1. Right-click the program button on the Start menu. 
  

4.2. Click on Pin this program to Start Menu. 
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How to work with Jump Lists from the Start Menu: 

 

To view the Jump List for a program: 

 

1. Click Start.  

 

2. Point to a pinned program or to a recently used program near the top of the Start menu. 

 

3. Point to or click the arrow next to the program.  

 

To open an item: 

 

1. Click Start.  

 

2. Point to a pinned program or to a recently used program near the top of the Start menu to open 

the program's Jump List.  

 

3. Click the item.  

 

To pin an item to a Jump List: 

 

1. Click Start, and then open the program's Jump List.  

 

2. Point to the item, and then point the cursor to its pushpin icon, and then click on the pushpin 

icon to pin the item to the Jump list.  

 

To unpin an item: 

 

1. Click Start, and then open the Jump List for the program. 

 

2. Point to the item, and then click on its pushpin icon to unpin the item from the list. 

 

How to Hide all Windows (Show Desktop) 

There are several ways to see your desktop without closing your open windows: 

1. Minimize all of your windows at once by clicking the Show desktop button next to the notification 
area at the end of the taskbar. 
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Figure 26 – Hide All Windows 
 

2. You can also temporarily preview or "peek at" the desktop by just pointing your mouse to the Show 
desktop button. The open windows are not minimized, but they fade from view to reveal the 
desktop.  
 

3. To show the windows again, just move the mouse away from the Show desktop button. 

How to Arrange Windows with Snap 

 

Snap is a quick way to resize open windows on your desktop. You can use Snap to arrange windows 

side by side, which can be especially helpful when comparing two documents or when moving files 

from one place to another. You can also use Snap to maximize a window. 

 

To snap a window to one side of the screen: 

 

1. Place the mouse cursor on the program title bar. 
 

2. While holding the left click, swiftly drag the title bar of a window to the left or right side of the 
screen until an outline of the expanded window appears. 
 

3. Release the mouse button to expand the window. 
 

4. Repeat steps 1 and 2 with another window to arrange the windows side by side. 
 

5. To return the window to its original size, drag the title bar away from the top of the desktop and 
then release. 

 

6. To perform the same feature using the keyboard, press the Windows Logo Key         . 
 

7. Press the left arrow key (or the right arrow key) to place the active window to the left side (or the 
right side) of the desktop. 

 

To maximize a window: 

1. Place the mouse cursor on the program title bar. 
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2. While holding the left click, swiftly drag the title bar of a window to the top of the screen. 
 

3. Release the mouse button to expand the window. 
 

How to Minimize all but one Window with Windows Shake 

  

You can quickly minimize all but one window to focus on a single task by using the Shake feature of 

Windows 7.  

 

To minimize all but one window:  

 

1. When multiple windows are open, point to the one window that you wish to work on. 
 

2. While holding the left click, shake the window and all other windows will be minimized. 
 

To bring back all minimized windows: 
 

1. While holding the left click, shake the same window again and all the other open windows will be 
back on your desktop. 

 

How to Create a Shortcut 

 

A shortcut is a link to an item (such as a file, folder, or program) on your computer. You can create 

shortcuts and then place them in a convenient location, such as on the desktop. 

 

To create a shortcut: 

 

1. Open the location containing the item you wish to create a shortcut for. 
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Figure 27 – Desktop (create shortcut) 

 

2. Click the Start button.  
 

3. Select All Programs. 
 

4. Select the Microsoft Office folder. 
 

5. Right-click on Microsoft Word 2010. 
  

6. Select Send to. 
 

7. Select Desktop (create shortcut), the MS Word 2010 shortcut appears on the desktop. 
 

To delete a shortcut: 

1. Right-click the shortcut on the desktop, select Delete.  
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Personalizing the Desktop 

 

How to add Gadgets to the Desktop 

 

Note:  The Windows 7 gadgets may impact your computer CPU performance and will require 

memory space to run effectively.  

 

Windows contains mini-programs called gadgets, which offer information at a glance and provide easy 

access to frequently used tools.  

 

To add a Gadget: 

1. Right-click the desktop. 
 

2. Select Gadgets.  

The gadgets window appears listing all available gadgets on your computer. 

 

Figure 29 – Gadgets Window 

3. Double-click on the desired gadget to add it to your desktop. 

To remove a Gadget: 

1. Right-click on the gadget you wish to remove from your desktop.  
 

2. Select Close gadget. 

Figure 28 – Gadgets Option 
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How to change the Desktop Background 

Your desktop background (also called wallpaper) can be a digital picture from your collection, a picture 
that comes with Windows, or a solid color.  

To change the desktop background: 

1. Right-click on your desktop. 

 

 

 

 

 

 

2. Click on the Personalize option. 
 

3. Select Desktop Background. 

 

Figure 31 – Desktop Background 

Figure 30 – Right-click Desktop Options 
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4. Click the picture or background image you wish to use from the available Windows 7 themes 
 

5. After you make your selection, click on the Save changes button.  The picture will be displayed on 
your desktop 

How to add a Screen Saver 

 

Windows comes with several screen savers. You can also create your own screen savers from personal 

pictures that you have saved on your computer. 

1. Right-click on your desktop.  
 

 

 

 

 

2. Click on the Personalize option.   
 

3. Select Screen Saver option. 
 

 

  

 

 

 

 

 

 

 

Figure 32 - Personalize Option 

Figure 33 - Screen Saver 
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The Screen Saver Settings window appears. 

 

Figure 34 – Screen Saver Option 

4. Click the Screen Saver drop-down arrow box. 
 

5.  Select the screen saver you wish to use. 
 

6. Click OK. 

How to Apply Themes 

You can add a personal touch to your computer by changing the computer's theme, color, sounds, 
desktop background, screen saver, font size, and user account picture. 

A theme includes a desktop background, a screen saver, a window border color, sounds, and 
sometimes icons and mouse pointers. You can choose from several aero themes. Use the whole theme 
or create your own customized theme by changing the pictures, colors, and sounds individually. 

To access themes: 

1. Right-click on your desktop.   
  

2. Select the Personalize option. 

  

Figure 35 - Right-Click Desktop Options 
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Figure 36 – Themes Window 

3. View the available themes.  

4. Select the theme you wish to use. 

How to change the Display 

 

Windows chooses the best display settings, including screen resolution, refresh rate, and color, based 

on your monitor. These settings differ depending on whether you have a LCD (flat-panel) or a CRT 

monitor.  If you need to adjust your display settings to make the text and other elements on the screen 

larger, follow the instructions below. 

 

To make it easier to read your screen: 

1. Right-click on your desktop.   
  

2. Click on the Screen Resolution   
option. 
 

 

Figure 37 - Right-Click Desktop Options 
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The Screen Resolution window appears.   

 

3. Click on Making text or other items larger or smaller.  

 
Figure 38 – Display Adjustment Window 

4. Select the smaller, medium, or larger display setting you wish to use, and Click Apply. 
 

5. Select the Adjust Clear Type text option. 
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Note: ClearType is a software technology developed by Microsoft that improves the readability of 
text on LCD monitors.  With ClearType font technology, the words on your computer screen look 
almost as sharp and clear as those printed on a piece of paper. 
 

To change the monitor resolution: 

 

1. Right-click on your desktop.  
 
 

2. Click on the Screen Resolution option.  
 
 
 
 

 
The Screen Resolution window appears. 
 

3. Click the drop-down arrow to the right of Resolution. 

 

 
           Figure 40 – Resolution Window 

3. Left-click and hold the white arrow pointing to the recommended resolution, and adjust the 
resolution. 

Note: The recommended resolution is 1280 x 1024. 

4. Click on OK. 

Figure 39 - Right-Click Desktop Options 
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Managing Files and Folders 

How to work with Recent Documents 

 

Windows 7 categorizes recent items by the program used to open them. 

 

1. Click the Start button to view the Start Menu; all recently used programs will be listed in the Start 
Menu. 

 
Figure 41 – Recent Documents 

2. Click the arrow to the right of some of the programs to expand the window. The recent files of 
each program are listed on the expanded section. 

3. Click on the file name to open it. 

Windows 7 lets you pin files to have them permanently displayed on the recent list. 

 

To pin a file: 
 

1. Point to the file, and click on the Pin icon to the right of it. 

To unpin a file: 

1. Point to the file, click on the Pin icon again. 
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How to work with Libraries 

Libraries are user-defined collections of folders that are logical representations of user content. By 

including folders in Libraries, you are telling Windows where your important data is located. The 

default folders are Documents, Music, Pictures, and Videos. 
 

 
Figure 42 - Libraries 

To access the Libraries: 

1. From the Taskbar, click on the Windows Explorer button.  
Figure 43 - Accessing Libraries 

How to create a new folder 

 

1. Open Windows Explorer. 

 

2. Access a Library such as the Documents Library. 

 

3. Click on the New Folder button that is located on the Toolbar. 

 

4. Enter a name for the new folder. 

 

5. Press the Enter key. 
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How to preview files in Windows Explorer using the Preview Pane 
 

Windows Explorer has a Preview Pane that can appear on the right side. This allows you to display the 

contents of text, graphic, video and other selected files without having to open them up.  By default, 

the Preview Pane is turned off. 
 

To display the Preview Pane: 
 

1. Open Windows Explorer. 

 

2. Press the ALT + P key combination on the keyboard  

OR click on the Preview Pane button on the top right 

portion of the window.  
 

 

Figure 44 - Turning On the Preview Pane 

3. Click on a file to display its content in the Preview Pane. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 45 - Using the Preview Pane 
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How to change the View in Windows Explorer 

 

The View is useful when you need to see information such as size, format 

and author quickly when browsing through files.  

 

The following views can be selected: Content, Tiles, Details, List, Small Icons, 

Medium Icons, Large Icons, Extra Large Icons. 

 

To change the view: 

 

1. Click on the icon to the left of the Preview Pane icon. 

 

 

 

 

 

 

 

 

 

 

 

2. Select on the available views. 

2.1. Content:  The Content view places files and folders in a row, and displays detailed information 

about each file and folder: date when it was last modified, size, author of the file, length (for 

audio and video files) etc.   

  

  

  

  

  

  

  

  

 

Figure 46 - Accessing the Views 

Figure 47 - Content View 
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2.2. Tiles: The Tile view shows medium-sized icons of each file and folder along with information 

about type and format. 

  

  

  

  

  

  

  

 

2.3. Details: The Details view splits the screen into columns to provide detailed information such as 

name, date modified, type, and size. 

  

  

  

  

  

  

  

2.4. List: The List view shows the content of a folder in a list which contains only the names of each 

file and its appropriate icon. 

  

  

  

  

  

  

  

2.5. Small, Medium, Large & Extra Large Icons: These four Icon views show the icon of each file 

and its name. The difference between them is in the size of the icons shown. 

 

  

 

 

 

 

 

Figure 48 - Tiles View 

Figure 49 - Details View 

Figure 50 - List View 

Figure 51 - Large Icons View 
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How to navigate with the Breadcrumb Bar in Windows Explorer 

 

The Breadcrumb Bar shows your current position in Windows Explorer as well as all previous ones.  

 

1. Simply click on any part of the breadcrumb trail to go to that particular location. (See Figure 52) 

 
Figure 52 - Breadcrumbs 

How to move files and folders 

Windows 7 allows you to move your files and folders from one location to another: 

1. Right-click the file or the folder you wish to move, click Cut. 

2. Double click to open the folder you wish to move the file or the folder to. 

3. Right-click inside the folder, click Paste. 

How to copy files and folders 

Windows 7 allows you to copy your files and folders from one location to another: 

1. Right-click the file or the folder you wish to copy, click Copy. 

2. Double click to open the folder you wish to move the file or the folder to. 

3. Right-click inside the folder, click Paste. 
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How to rename files and folders 

There is a quick way to rename your files or folders: 

1. Right-click the file or the folder you wish to rename, click Rename. 

2. Type the new name, press Enter. 

How to delete files or folders 

1. Select the file or folder you wish to delete. 

2. Press the delete key on the keyboard. 

How to restore deleted files or folders 

 

1. Double click to open the recycle bin. 

2. Right-click the file or the folder you wish to restore. 

3. Select Restore.   

The file will be restored to its original location. 

How to search in Windows 

 

There are several ways to perform a search and find files, folders, and programs in your computer. 

Search in Windows 7 works in a contextual way depending on what you are searching in.  For instance, 

search in the Start Menu prioritizes Start Menu items and programs; search in Windows Explorer 

prioritizes documents and pictures. 

 

To search for programs and files from the Start Menu: 

 

1. Click the Start button.  
 

2. Start typing into the start menu search field. 
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Figure 53 – Search field 

1.1.1 As you start typing, a list of relevant programs, documents, pictures, and videos on your 
PC instantly appears. 
 

1.1.2 Results are grouped by category and contain highlighted keywords and text snippets to 
make them easier to browse. 

 

Note: You can also open the search window by pressing Window logo key        + F. 

 

Note: The Search field accessed from the Start Menu is also the Run command field. This is where you 

would type the “info” command when asked to locate the IP address of your computer for remote 

assistance by the KSU Service Desk. 
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Windows Tools 

The Snipping Tool 

 

The Snipping Tool captures a screen shot of anything on your desktop, like a picture or a section of 

webpage. Snip a whole window, a rectangular section of the screen, or draw a freehand outline with 

your mouse or tablet pen (or your finger, if you are using a PC with a touchscreen). Then you can 

annotate, save, or e-mail the image using buttons right in the Snipping Tool window. 

 

To capture a snip: 

1. Click the Start button, in the search box type Snipping Tool. 
 

2. From the list of results, select the Snipping Tool. 
 

3. From the Snipping Tool small window, click the down arrow to 
the right of the New button. 

 

Figure 55 – New Button 

4. Select the option you wish to use: Free-form Snip, Rectangular Snip, Window Snip, or Full-screen 
Snip. 
 

5. Select the area of your screen that you want to capture.   

The captured area appears in the Snipping Tool window. 

6. In the Snipping Tool window you can write, draw on or around the 
screen capture. 
 

7. After making the necessary edits to the screen capture, click the Save 
Snip button. 

Figure 54 – Sipping Tool 

Figure 56 – Save Snip 
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8. In the Save As dialog box, enter the name of the snip, choose a location where to save the snip, and 

then click Save. 

Windows Paint 

 

The Microsoft Paint software has adopted the Office ribbon style interface and has grown into a 

powerful yet simple image and photo editor tool. Paint is a feature in Windows 7 that you can use to 

create drawings on a blank drawing area or in existing pictures. Many of the tools you use in Paint are 

found in the ribbon, which is near the top of the Paint window. 

 

1. Click the Start button.  
 

2. Select All Programs. 
 

3. Click on Accessories and select Paint.  The Paint window appears. 

 

 
Figure 57 – Paint Window 

To insert Text into a picture: 

1. From the Ribbon, on the Home Tab, in the Tools group, click the Text tool. 
 

 

Figure 58 - Text Tool 

2. Click in the drawing area where you want to add text. 

 

3. Under Text Tools, on the Text tab, select the font, size, style and color. 
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4. Type the text that you want to add. 

To use the Pencil tool: 
 

1. From the Ribbon, on the Home Tab, in the Tools group, click the Pencil tool. 
 

 

 
       
  
  

                       Figure 611 – Pencil Tool 

2. From the Colors group, click Color 1, and choose a color. 
 

3. Drag the mouse/pencil icon in the drawing area to draw. 
 

 

To use the Brushes tool: 
 

1. From the Ribbon, on the Home Tab, click the down arrow under Brushes, and select the brush you 
wish to use.  
  
  
  
  

Figure 60 - Text Tools Options 

Figure 59 - Entering Text 

 
 
 
 
Figure 62 - Brushes Tool 
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2. Click the down arrow under Size, select the line size, which determines the thickness of the brush 
stroke.  
 

3. From the Colors group, click Color 1, and choose a color.  
 

4. Drag the mouse/brush in the drawing area to draw. 
 

To use the Line tool: 

1. From the Ribbon, on the Home Tab, in the Shapes group, select line tool. 
 

 
                                    Figure 62 – Line Tool 

2. Click down arrow under Size, select the line size. From the Colors group, click Color 1, and choose a 
color.   
 

3. (Optional) To change the line style, in the Shapes group, click Outline and then click a line style.  
 

4. Drag the mouse/line tool in the drawing area to draw. 
 

To use the Curve tool: 

1. From the Ribbon, on the Home Tab, in the Shapes group select curve tool. 
 

 
                                  Figure 63 – Curve Tool 

2. Click down arrow under Size, select the line size.  
 

3. From the Colors group, click Color 1, and choose a color.  
 

4. Drag the mouse/line tool in the drawing area to draw.  
 

5. After you have created the line, click the area in the picture where you want the arc of the curve to 
be, and then drag the pointer to adjust the curve. 
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Windows Speech Recognition 
 

You can use your voice to control your computer. You can say commands that the computer will 

respond to, and you can dictate text to the computer. 

 

To set up the Speech Recognition: 
 

Before you get started using Speech Recognition, you'll need to set up your computer for Windows 

Speech Recognition. There are three steps to setting up Speech Recognition:  

 

Step 1: Set up your microphone  

 

1. Connect your microphone to your computer. 
 

2. Click the Start button, select Control Panel. 
 

3. Select Speech Recognition option, select Set up microphone.  
 

4. Follow the set up wizard instructions:  
 

 Select the type of microphone you are using, click Next. 

 Position the microphone close to your mouth, click Next. 

 Read the sentences as instructed by the system, click Next. 

 If all done successfully, you will receive a confirmation, click Finish. 

Step 2:  Learn how to talk to your computer  
 

1. Select Take Speech Tutorial. 
 

2. Follow the instructions in the Speech Recognition tutorial. 

Step 3: Train your computer to understand your speech 
 

1. Select Train your computer to better understand you. 
 

2. Follow the wizard instructions: 
 

 Read the welcome screen, click Next. 

 Complete the Speech Recognition training, click Next. 

 (Optional) Click Send to share your Speech Recognition training experience with 
Microsoft. 
 

Figure 64 – Set up Microphone 

Figure 65 – Talk Speech Tutorial 
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To start Speech Recognition: 
 

1. Make sure your microphone is connected. 
 

2. Click the Start button, select Control Panel. 
 

3. Select the Speech Recognition option.  The Speech Recognition tool appears at the top of your 
screen. 
 

Windows Calculator 

 

You can use the calculator to perform simple calculations such as addition, subtraction, multiplication, 

and division. The calculator also offers the advanced capabilities of a programming, scientific, and 

statistical calculator. 

 

1. Click the Start button.  
 

2. Select All Programs. 
 

3. Click on Accessories.  
 

4. Select Calculator. 
 

 

 

 

 

 

5. Click on the calculator keys to perform the calculation you want. 
 

Figure 66 – Speech Recognition 

Figure 67 – Opening the Calculator 
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                 Figure 68 – The Calculator 

To access additional calculator modes: 

1. Click on View. 
 

2. Select the mode you want to use: Scientific, Programmer or Statistics. 
 

 

 

 

 

 

 

 

 

3. Continue using the calculator keys to perform your calculation. 

 

The calculator also sports new elements, which are to be found under the View menu.  

 

 Date Calculation calculates the duration between two periods of time.  

 

 Unit Conversion converts measurement units for angles, area, energy, length, mass, power, 

pressure, temperature, time, velocity, and volume.   

 

Figure 69 – Calculator View Menu 
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Figure 70 - Calculator - Unit Conversion 

 Worksheets: A set of four templates calculate lease and mortgage payments, and gas mileage. 

All you have to do is pick the desired worksheet and complete the fields available for the 

application to calculate the result.  

 

 

 

 

 

 

 

 

 

 

 

Sticky Notes 

 

The Sticky Notes applet can be used to write a to-do-list or jot down an email address. The note will 

then appear on your desktop as if you had placed a post-it note on your screen. 

 

 

 

Figure 71 - Calculator - Mortgage Payment 
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To create a Sticky Note: 

 

1. Click on the Start button. 

 

2. Type Sticky Notes in the search box. 

 

3. Click on Sticky Notes in the list of results. 

 

4. Enter your note. 

 
Figure 72 - Sticky Note 

When you create a note, the Sticky Notes applet automatically saves the note. This means that you can 

close the Sticky Notes applet without fear of losing your notes. 

 

To save and close the Sticky Note: 

 

1. From the Taskbar, right-click on the Sticky Notes button. 

 

2. Click on Close window. 

 

When you re-launch the applet, all your notes reappear. 

 
Figure 73 - Closing Stick Notes 
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To delete the Stick Note: 

 

1. Click anywhere on the Sticky Note. 

 

2. Click on the X mark on the upper-right corner. 

 

The Delete Note confirmation screen appears. 

 
Figure 74 - Deleting a Sticky Note 

3. Click on Yes. 

 

To create another Sticky Note: 

 

1. Right-click on the Sticky Notes button on the Taskbar. 

 

2. Select + New Note. 

 

 

 

Windows Photo Gallery 

 

Note: KSU computers and their operating system are property of Kennesaw State University.  They 

are not to be used to store photos, video, music, and audio files of a personal nature. Doing so uses 

precious storage space that is needed for learning and work related purposes and can be in violation 

of copyright laws in some cases. 

 

With Photo Gallery, it is a snap to get your photos and videos from your camera to your PC. Find your 

favorite photos and manipulate them for use in publications. Make your great photos look even better, 

and create impressive panoramic photos too. 

Figure 75 - New Sticky Note 
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What can be done with Windows Photo Gallery: 

 

1. Organize Photos 
 
You can search, sort and organize your photos and videos a number of different ways, including by 
photo captions and tags. To make tagging the people in your photos easier, Windows Photo Gallery 
automatically locates people in your photos while you browse through them. Further, tags and 
captions are retained when you publish your photos and videos so people know more about the 
photos and videos you share. 
 

2. Edit Photos 
 
In a click, the Auto adjust feature adjusts a photo to improve its alignment, exposure, and color. 
After the photo has been auto-adjusted, Windows Photo Gallery shows what has changed so you 
can see what each the various editing tools do and make further refinements. If you prefer, you can 
manually edit your photos instead. 

In addition to editing features, Windows Live Photo Gallery has features you can use to create 
panoramas, movies, and slide shows.  

 

Windows Movie Maker 

 

Note: KSU computers and their operating system are property of Kennesaw State University.  They 

are not to be used to store photos, video, music, and audio files of a personal nature. Doing so uses 

precious storage space that is needed for learning and work related purposes and can be in violation 

of copyright laws in some cases. 

 

Automatically turn your videos, photos, and music into a video production. AutoMovie adds a title, 

credits, transitions, and effects, and fits it all together for you.  Customizing your video is simple with 

easy-to-use editing tools. Trim your video clips to show only the parts you want. Add titles, transitions, 

music, and effects like panning and zooming.  You will be able to publish your work-related videos, and 

share them with students, faculty and staff in different ways. 

 

What can be done with Movie Maker: 

 

1. Create movies using photos and videos. Use what you have taken with your mobile phone, digital 
camera, or video camera. Trim videos to show only the parts you want in your movie. 
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2. Get creative with music, text, transitions, and effects. Use these features to make a great movie 
that you will want to share with others. 

 

3. Make dynamic slide shows using your favorite photos and music. Add pan and zoom effects to 
make the photos glide across the screen and show close-ups of your favorite photos as the music 
plays. 

 

4. Save and share your movie with students, faculty and staff.  Share in a variety of ways—including 
on the web, in an e-mail message, or on DVD. 

Note: Please refer to the Movie Maker booklet for step-by-step instructions on how to use the program. 

 

Problem Steps Recorder 

 

The Problem Steps Recorder is a very helpful tool that enables you to record your interactions with an 

application and provide a detailed screen-by-screen view with accompanying information to the KSU 

Service Desk. In other words, Problem Steps Recorder will allow you to effectively capture any issues 

you may have with your computer, and accurately report them to the KSU Service Desk. The recording 

can then be used to quickly identify problems and help reduce time spent with the help desk. 

 

The following instructions will show you how you can easily use Problem Steps Recorder to 

automatically capture the steps you take on a computer, including a text description of where you 

clicked and a picture of the screen during each click (called a screen shot). Once you capture these 

steps, you can save them to a file that can be used by the KSU Service Desk. 

 

To use the Problem Steps Recorder: 

 

1. Click the Start button, in the search field type PSR 
  

2. Click the PSR application from your search results.  
 

The Problem Steps Recorder program tool bar appears.  

 
Figure 77 – Problem Steps Recorder 

3. Click the Start Record button. 
 

4. Go through the steps on your computer to reproduce the problem you are having. 

Figure 76 – Search field 
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5. When you want to add a comment, click the Add Comment button. 
 

6. Use your mouse to highlight the part of the screen that you want to comment on. 
 

7. Type your text in the Highlight Problem and Comment box, click OK. 
 

8. Click the Stop Record button. 
 

9. In the Save As dialog box, type a name for the file.  
 

10. Select the location you want to save the file to. 
 

11. Click Save.  The file is saved with the .zip file name extension. 
 

12. To view the record of the steps you recorded, double click on the .zip file you just saved. 
 

13. Double-click the file. The document will open in your browser. 
 

14. To send the .zip file you recorded to the ITS Service Desk (email: service@kennesaw.edu), attach 
the .zip to an e-mail message. 
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Ease of Access 

The Magnifier 

The magnifier enlarges different parts of the screen. This is especially useful for viewing objects that 
are difficult to see, but also for seeing the whole screen more easily. 

There are three modes: 

 Full-screen mode - In full-screen mode, your entire screen is magnified. You can then have 
Magnifier follow the mouse pointer. 
 

 Lens mode - In lens mode, the area around the mouse pointer is magnified. When you move 
the mouse pointer, the area of the screen that's magnified moves along with it. 
 

 Docked mode -In docked mode, only a portion of the screen is magnified, leaving the rest of 
your desktop in a normal state. You can then control which area of the screen is magnified. 

To use the Magnifier option: 

1. Click the Start button 

2. Select All Programs. 

3. Select the Accessories folder. 

4. Select the Ease of Access folder.  

5. Select Magnifier. 

A magnifier icon appears on your screen, and the view in your screen may increase. 

6. Click the magnifier icon once, the Magnifier tool bar appears 

 

       Figure 79 – Magnifier Tool 

7. Click the – or + signs to adjust the zoom. 

Figure 78 - Magnifier 
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8. Click the Views option, list of the available views displayed.    

9. Select the view mode option you wish to use. 

10. Move the icon to the part of the screen you want to magnify. 

 

 

Magnifier Shortcuts Functions 

 

   + plus (+) or minus (-) sign 

 

Zoom in or out 

   + Esc Exit Magnifier 

 

The Mouse 

You can change how the mouse pointer looks, and turn on other features that can help make it easier 
to use your mouse. 

1. Click the Start button.  

2. Select Control Panel. 

3. Click on Ease of Access Center.  

4. Click on Make the mouse easier to use. 

5. Select the options you want to use: 

 Change the color and size of mouse pointers - You can use these options to make the mouse 
pointer larger, or change the color to make it easier to see. 
 

 Turn on Mouse Keys - You can use this option to control the movement of the mouse pointer 
by using the numeric keypad. 
 

 Activate a window by hovering over it with the mouse - This option makes it easier to select 
and activate a window by pointing at it with the mouse rather than by clicking it. 
 

 Prevent windows from being automatically arranged when moved to the edge of the screen - 
This option prevents windows from automatically resizing and docking along the sides of your 
screen when you move them there. 

Figure 80 – Magnifier Available Views 

Figure 81 – Make the Mouse Easier to use link 
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The Keyboard 

You can use your keyboard to control the mouse and make it easier to type certain key combinations. 

1. Click the Start button.  

2. Select Control Panel. 

3. Click on Ease of Access Center.  

4. Click on Make the keyboard easier to use. 

5. Select the options you want to use: 

 Turn on Mouse Keys - This option sets Mouse Keys to run when you log on to Windows. Instead 
of using the mouse, you can use the arrow keys on your keyboard or the numeric keypad to 
move the pointer. 
 

 Turn on Sticky Keys - This option sets Sticky Keys to run when you log on to Windows. Instead 
of having to press three keys at once (such as when you must press the Ctrl, Alt, and Delete 
keys together to log on to Windows), you can use one key by turning on Sticky Keys and 
adjusting the settings. This way, you can press a modifier key and have it remain active until 
another key is pressed. 
 

 Turn on Toggle Keys - This option sets Toggle Keys to run when you log on to Windows. Toggle 
Keys can play an alert each time you press the Caps Lock, Num Lock, or Scroll Lock keys. These 
alerts can help prevent the frustration of inadvertently pressing a key and not realizing it. 
 

 Turn on Filter Keys - This option sets Filter Keys to run when you log on to Windows. You can 
set Windows to ignore keystrokes that occur in rapid succession, or keystrokes that are held 
down for several seconds unintentionally. 
 

 Underline keyboard shortcuts and access keys -This option makes keyboard access in dialog 
boxes easier by highlighting access keys for the controls in them. 
  

 Prevent windows from being automatically arranged when moved to the edge of the screen - 
This option prevents windows from automatically resizing and docking along the sides of your 
screen when you move them there. 

 

 

  

Figure 82 – Make the Keyboard Easier to use link 
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Action Center 

Action Center is a central place to view alerts and take actions that can help keep Windows running 
smoothly. Action Center lists important messages about security and maintenance settings that need 
your attention. Red items in Action Center are labeled Important, and indicate significant issues that 
should be addressed soon, such as an outdated antivirus program that needs updating. Yellow items 
are suggested tasks that you should consider addressing, like recommended maintenance tasks. 

To access your computer Action Center: 

2. Click the Start button.  

3. Select Control Panel. 

4. Click on System and Security.  

5. Select the System option.  The System window appears. 

 

Figure 83 – System Window 

3. Click the Action Center link. 
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Figure 84 – Action Center 

4. To view details about either the Security or Maintenance section, click the down arrows to the 
right of each section to expand the list. 

Action Center Short Cut 

1. If there are any issues with your computer a white flag will appear in the notification area at the 
right of the task bar. 

 

Figure 85 – Action Center White Flag 

2. Click the white flag icon to view more details. 

 

Figure 86 – Action Center Message 

3. Click the message to view the issue. 

4. To resolve the issue contact the ITS Service Desk at (770) 423-6999. 
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Windows 7 Popular Shortcuts  

 

Windows Taskbar Shortcuts Functions 

   

   
 

 SHIFT + click on taskbar icon 

 

Opens/Closes the Start menu 

 

Launches a new instance of a program 

 Drag up from a taskbar icon Opens Jump List 

 Right-click from a taskbar icon Opens Jump List 

 

    + T 

 

Cycles through programs on the taskbar 

 

Managing Windows Shortcuts Functions 

 

   + Arrow 

 

Cycles through window arrangements for a 

window (i.e.: snap, maximize, minimize) 
 

 Alt + Tab Cycles through open applications and folders 

 

   + Tab 

 

Cycles through open windows in a 3D queue 

sequence 

   

   + D 

 

Displays the Desktop 

   

   + Shift + Left/Right Arrow 

 

Move a window from one monitor to another 

 

Windows Explorer Shortcut Function 

 Alt + P 

 Alt 

Shows/hides preview pane 

Displays Windows classic menu 
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Additional Training Resources 

Windows 7 Online Development Path 

To access the Windows 7 online development path: 

1. Open your web browser and login to https://computertrain.kennesaw.edu 
  

2. From the menu bar, click the Professional Development option, select Development paths. 
 

3. Select the Windows 7 link. 
 

4. Select the title of the course you wish to take. 
 

5. Click the “Begin Course” link located at the right side of the table. 
 

6. The course window appears. Click the next arrow button to begin the tutorial. 
 

7. Make sure your computer speakers are turned on, and enjoy the online tutorial. 

Windows 7 Live Training Workshops 
 

To register for Windows 7 training workshops: 

1. Point your web browser to ITS Dept Windows 7 support site at: 
http://its.kennesaw.edu/windows7/index.html 
 

2. Review the Windows 7 support resources provided. 
 

3. Click the Training link located at the right side of the screen. 
 

4. Login with your NetID and Password. 
 

5. Click the Catalog option from the menu bar. 
 

6. Select the Center for University Learning link.  
 

7. Select the Windows 7 course. 
 

8. Read the “Overview”. 
 

9. Select the “Upcoming Sessions” tab. 
 

Figure 87 

https://computertrain.kennesaw.edu/
http://its.kennesaw.edu/windows7/index.html
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10. Review the date and time of the available sessions. 
 

11. To enroll for a session, click the Enroll button in the top right corner. 
 

12. A registration confirmation page will appear, click OK. 
 

13. You are now registered for the training session. 

 

KSU Service Desk Support 

 Email: service@kennesaw.edu 

 Phone: (770)423-6999 

  

mailto:service@kennesaw.edu
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Windows XP 
versus  

Windows 7 
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Windows XP vs Windows 7: 

 
A Comparison Chart of New and Improved Features  

 

 

 

from the current theme or using a format that you specify directly. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

Created:  8/5/2010  Page 57 of 59 
Revised: 11/16/2010   
  

 Windows XP Windows 7 

Jump lists n/a Jump lists provide unprecedented 
ease of access to files and 
programs Windows XP does not 
have. With jump lists you can right 
click on an icon on the taskbar and 
Windows 7 will instantly provide a 
list of the most often used 
application for that program. For 
example if you right click on 
internet explorer, you will be 
provided with a list of the most 
recently visited websites that 
have been viewed. No more 
digging through history files to 
find it.  
 

Pins – documents and websites n/a You can pin files, documents, and 
websites to the taskbar for 
frequent, easy access.  

Pins - programs Click the icon for the program 
you want to add, and then drag it 
to the Quick Launch portion of 
the taskbar located next to the 
Start button. 

You can easily customize the 
taskbar by pinning commonly 
used program shortcuts with the 
click of a button. By scrolling over 
this shortcut with the mouse, you 
will be able to preview the most 
recently opened instance of that 
application for a quick peek at 
what is there. For a program that 
is used frequently, simply right 
click on the programs icon and 
choose “pin to taskbar”. There will 
then be an easy to use shortcut to 
the application on the taskbar. 
 

Search The Search Companion locates 
files and folders. It can be a very 
time consuming process. 

Windows Search quickly finds files 
and programs, from documents to 
emails to applications, right from 
the Start Menu. Additionally, 
almost every window has a search 
area in the top right corner. 
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Sizing & arranging open windows Right-click an empty area on the 
taskbar, then click on cascade 
windows, tile windows 
horizontally, or tile windows 
vertically. Windows that are 
reduced to taskbar buttons will 
not be displayed. 

With Snap, size and arrange 
windows by simply dragging their 
borders to the edges of your 
screen.  Instantly expand to full 
screen and back, or arrange two 
windows side by side. 

Viewing only one open window Minimize the windows you want 
to hide one-by-one. To restore 
the windows, click on their 
respective taskbar buttons one-
by-one. 

The Shake feature allows you to 
hide all other open windows by 
simply shaking the window you 
want to keep on display. Shake 
the window again and all other 
windows reappear. 
 

Viewing what is behind an open 
window 

You cannot view through an 
open window. 

The Peek feature allows you to 
peer past all open windows 
straight to the desktop by moving 
the cursor over a little transparent 
rectangle in the lower right corner 
of the screen. 
 

Previewing the content of a 
minimized window 

You cannot preview the content 
of a minimized window from the 
taskbar. 

With Aero Peek, you will see a 
preview of the window for a quick 
peek at what is there, by scrolling 
over a minimized window with the 
mouse. 
 

Previewing all open windows 
without accessing the taskbar 

n/a With Aero Flip 3D, you can quickly 
preview all of your open windows 
(i.e.: open folders, documents, 
programs) by moving the windows 
in a 3D queue so that you can see 
all of your windows in sequence. 
Activate the Aero Flip 3D by 
pressing the Windows and the tab 
keys together. 
 

Speech Recognition n/a You can use your voice to control 
your computer. You can say 
commands that the computer will 
respond to, and you can dictate 
text to the computer. 
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Problem Steps Recorder n/a The Problem Steps Recorder in 
the Windows 7 operating system 
is a very helpful tool that enables 
you to record your interactions 
with an application and provide a 
detailed screen-by-screen view 
with accompanying information to 
the KSU Service Desk. 

Paint Paint is a drawing tool you can 
use to create simple or elaborate 
drawings. These drawings can be 
either black-and-white or color. 
You can print your drawing, use 
it for your desktop background, 
or paste it into another 
document. 

The new Paint in Windows 7 has 
adopted the Office ribbon style 
interface and has grown into a 
powerful yet simple image and 
photo editor tool. 

WordPad WordPad has always come in 
very handy as a quick and easy to 
use text editor for documents. 
Rather than opening up a new 
Word session to make simple 
adjustments, WordPad can save 
a lot of time. In fact it is all that is 
needed to create basic letters 
and other simple documents.  

The new WordPad in Windows 7 
includes the nicely laid out Ribbon 
interface as well as improvements 
to the options and features 
available. 

Power Management Data about remaining power is 
not always accurate. 

Windows 7 intelligently decreases 
power consumption by 
monitoring CPU state and 
reducing the amount of disk 
activity. It also provides more 
accurate reports about remaining 
power. 

Performance Improvements over 
XP 

 Windows 7 is designed to sleep 
and resume quicker, be less 
memory hungry, and spot USB 
devices faster. 

   

   
 

 


